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Record of Amendments

Keep this record in the front of the User Manual. When the document has been amended
write the amendment number, the date, the paragraph numbers affected by the
amendment and your initials in the table below.

Amendment Amendment Reason for Re-Issue Amended by
Number Date (Paragraph Number (s) Amended)
1.0 9 July 2007 First draft AMB
1.1 18 July 2007 Issued AMB
1.2 16 Jan 2008 Added information about charging AMB
1.3 28 May 2008 Added more information about changing AMB
default sensor type
1.4 2 July 2008 Added information about daisy chaining AMB

cases together
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Introduction

Components

SoundSens correlation pods
SoundSens carry case
Software CD

Mains charger

Download leads

(1 x Serial, 1 x USB)

o

Concept

The SoundSens system comprises a powerful software package and the new SoundSens i
pods which can be setup in the field with or without a PC. Recordings can be stored in the
memory of the pod, or the unit can be used with a PC to correlate in the field as a
multipoint unit carrying out the test straight away or as a delayed test ie: over night.

SoundSens i can store four sets of recording sessions. This is equivalent to 4 nights of

data storage. The SoundSens PC software contains help files for using the PC to setup,
download and analyse recordings.

This manual was written using SoundSens software version 3.2.1 and Radcom SoundSens i sensors.

SoundSens User Guide
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Charging the Carry Case

The carry case contains rechargeable batteries. It must be charged for 24 hours before
first use. Re-charge the carry case when the battery status LED starts to flash RED. The
data will be lost if the unit goes completely flat. However the battery low LED will give
plenty of notice of a low battery (i.e. days) and should be seen as an indication to
download data and re-charge.

The charge in the carry case battery pack should last approximately two months
depending on how frequently it is used.

To charge the batteries plug the supplied mains charger into the charging socket next to
the battery status LED. While charging the LED will flash ORANGE.

When the batteries are charged the battery status LED will flash GREEN (even if the
charger is still connected).

SoundSens User Guide
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Setting Up SoundSens

Setup With PC

Start the software

Andy Barnes

Internet
Internet Explorer

@ I%;‘oasiulft Office Out|
!)H Paink

“ L=t

e Windows Media Play
:3 Windows Messenger
t@ Taur Windows XF

. Files and Sattings Tr
L Wizard

f

All Programs | |

Radcom SoundSens - Unti

@000 0000 ve 68

-

Hogogescohodan

Ele Comms Corelation Yiew Tools Window Help

Set Program Access and Defauits

“Windows Catalog
windows Update
Micrasoft Lipdats

Accessaries

Check Point YPN-1 SecureClient
F-Secure Anti-virus Client Security
Games

iPass

Microsoft Office

Micrasoft Qutlook with Business Contact Manager
Microsoft Works

Pegasus Opera 11

Sonic

Startup

Adobe Reader 7.0

Internet Explorer

Microsoft Works Task Launcher
M3M

Qutlack Exprass

PowerDVD

Remote Assistance

Windows Media Player
Windows Messenger

‘windows Mavie Maker

Dell TrueMobile 5100

Intel Metwark Adapters

Radlog Faor Windows

Radwin Lite

SoundSens @8 Language Selector

=] readme

| o]

Wieard Bar

x| [

0 New

2 Open

il

1 Recording Setup

2 Create Pipe Layout

3 Download

4 Corelate

S

Save After Each Stage

Bt

| & | e8| Y| -

‘Soundsens Organiser
Pipe Layaut
Recordings

SoundSens

Tois | SeachRout |

Connecting the Hardnare:
Conliguing  Recording g

Introduction

SoundSens is a powerul sofwars package
used with SoundSens CP (Correlation Poc)
Loggers to identify the presence of leaks in
pipe work and determine the actual position
of those leaks using conelation techniques.
IThe Leak noise data i stored by the
SoundSens sofware onta the PC's internal
Hard Drive ar can be stored across @
Networkto a File Server.

(Conelation analysis can be undertaken On
site"with a Lap Top PC, or can be
downloaded fror the Correlating Pade at 2
Iater time. Furthermare the callected data
can be re-analysed from the fles stored on
lthe PC's hard drive or fle server with
altemative filter settings and correlation
rocessars if required.

Getting Started

[This help bar may be increased in size by

dragging its left side, or made full size with
fthe maximise button.

Itrmay be remaved from the display with its
Close bution, or via the View Menu aption.

[The View' menu may also be used to
display the bar after it has heen removed

[The inital state of the help bar may be
confiqured in the Startup’ options, found on_ ¥

Run the SoundSens software from the Start
menu as illustrated here.

The opening screen for the SoundSens
software.

SoundSens User Guide
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Connect the carry case to the PC

Serial (RS232) Communication Cable

The male end of the cable plugs into the Master
Serial connector on the carry case, and the female
end plugs into your laptop or PC.

See next page for further information

v

MASTER uss SLAVE
SERIAL SERIAL
1
o| [o 0| lo
L | | I |

USB Communication Cable

The A end (rectangle shape) plugs into your PC or
laptop, and the B end (square shape) plugs into the
USB connector on the carry case.

Found New USB Device 4 This message will appear indicating the
Sensor Type [Production Sensor 111 [ software has detected the case
Port: |%" SoundZens i USE Bridge Controller (COMS) j

Enien See next page for further information

SoundSens User Guide
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Information regarding connection via Serial RS232

When you connect the carry case to your laptop or PC via the Serial (RS232) cable the PC
will not do anything. You must select the correct communications port manually.

1 IE! Window Help
et

Cpkions. .,

From the Tools menu click Options
Import, ..

Export. ..
Impork Pipe Layout...
Export Pipe Layout...

Edit Pipe Layout Id's, .. . .
Then select the Communications tab (see below)

— L

Options...

: Communications - Select the comm port bo uze to connect the soundens suitcasze to
T the PC. Uze 'Help - Find Awvailable Ports' for more infarmation on available ports. Z
W Cancel

COMS _/{D

[v Maonitor USE Porkz. Prompt when USE device connechion changes

Synchronization Caonfirmation

Iv Prompt on detailed setup
| Prampt on quick setup

Help - Find Avallable Ports...

Select the correct port from the drop down list.

For extra help please see page 54 or contact the Radcom technical support team.

SoundSens User Guide
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Information regarding connection via USB

With the software started connect the SoundSens carry case to the PC using the USB
communication cable.

This message will appear indicating the

£ TS 4] software has detected the case.
Sensor Tyvpe |Pr0ducti0n Sensor 11T j
Fart: |£" SoundSens i USE Bridge Controller {(COMS) j

Select | Caneel |

On the Sensor Type drop down menu you can select the following

Found New USB Device 3

Sensor Type |Pr0duction Sensor 111 j

Pre-Production Sensor —_|
Production Sensor OMS) st
Production Sensor 11
Production Sensar 11T

Part:

Cancel |

Pre Production Sensor

Production Sensor (The original SoundSens logger)
Production Sensor Il (Dark blue plastic logger)
Production Sensor IlI (Otherwise known as SoundSens i)

The port drop down menu is usually picked automatically.

Found New USB Device

Sensar Type |Pr0ducti0n Sensor 11T

[~

Part: |=E> SoundSens i USE Bridge Controller {COMS) j

&7 Comt ~
oMz

&7 Com3
COoM4

SoundSens i USE Bridge Contraller (COMS)
COME b

Found New LISB Device i .
Click Select to continue.

Sensor Type |Pr0ducti0n Sensar 111 j

Port: |8 CP2103 USE to LART Eridge Controller (COMS) |

Cancel |

SoundSens User Guide
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Information regarding daisy chaining multiple cases together

To communicate with multiple cases you need to connect them together using SoundSens
serial communication cables, and then via USB to the PC.

The suitcase lid will have an arrangement of D shape communication ports and a USB
port.

There are variations on the lid as shown below.

oK CANCEL MODIFY OK CANCEL MODIFY
™ ™ N TN -, ™,
‘ /| [ | [_ __../'| ‘ b e _,_./'| [ | [ |
MASTER SLAVE
use TO TO
SERIAL SERIAL MASTER UsB SLAVE
ol o ol lo o ]
L / 1 | ol [© | |
E ad :_l nad E MASTER SLAVE SLAVE
9 usa 15 5 UsE 15 g USE 15
Ciwwiw|wdo
o e [ ] | |

In all situations you need to daisy chain the cases as shown below.

MASTER SLAVE SLAVE
9 (1] 15 £l LSB 15 5 LUSE 15

R W W 0O W w Qo

Note: You can not chain together 4 pod kits, but one 4 pod kit can be connected to the end
of a chain of 8 or 6 pod kits.

SoundSens User Guide
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and correlation

Communication Test

5 Radcom SoundSens - Untitled

A

Wwizard B ar

k3| untitled

=1 SoundSens Organiser

User, Defined Logger Parameters

Pozition | Suitcaze Number | User Defined |0 | Site Info

1 1 N —

2 1 3730 Cancel

3 1 3727 Q
4 1 3723

5 1 3728

1 1 75 Duplicate

7 1 I7E Site Info

g 1 3729

REMEMBER TO SAVE REGULARLY

‘wfizard Bar X

With the carry case (or cases)
connected to your PC or Laptop
click the sixth icon on the menu
bar.

The software will now
communicate with the case (or
cases) and loggers.

The list which pops up shows the
logger positions in the case. If any
loggers have failed to communicate
they will be missing from this list.

Click Ok.

Every other time you click save th
other action will be required.

N Click Save Type a name S — L
ew . Savein |53 SoundSens =] < £f B
for your flle‘ LY [B)or_07_05_10_09_15.55d
= Open \_ﬁ [H07_n7_03_t0_13_34.5sd
My Recent B 07_07_03_15_46_0d.ssd
1 Recording Setup Make Sure the D%nts E;ZE;ZE::?EZ;EZEEZ:
file name has oy (B0 0
2 Create Pipe Layout nOt been used Hor 0705 11 11 00554
[ o7_o7_09_11_16_44.ssd .
3 Download before. N Click Save
4 Correlate
é My Computer
Save )5 r
SavEdter Eakratage ‘:‘]
MyF‘T::t:‘smk File name: |50und5 ens Tesf j 538
Save as lype: |Snund8 ens Document(” ssd) j Cancel
You will only be prompted to type a file name if you have not clicked
save before.

e updates will be saved but no

SoundSens User Guide
©Radcom (Technologies) Ltd
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Quick recording setup

Wizard Bar x| File Comms Carrelation Wiew Tools  Windo
O New 1= -
“Wizard Bar
=3 Open -1 SoundSens Organiser
D NEW Pipe Layout
Recordings
1 Recording Setup
= Open
2 Create Pipe Layout
3 Download 1 Recording Setp
4 Comelate
: Connect the carry case to your PC or Laptop.
Save Y y ptop
s2u0 il Essh St To setup a quick recording either click the Recording Setup button on the
Wizard Bar (left image), or click the 7™ button on the menu bar (circled
above).
Quick Recording Series Setup Pz|
. 1E.D[.‘“JM:1ID:IJ4 14:2|5:14 14:4I|J:24 14:5|5:34 15:1|IJ:44 Thls IS the QUICk ReCOrdIng Serles Setup
- window which will pop up after clicking the
Start Series .
|:§ @ & Time/Date  |03/07/2007 »| 147000 = Recordlng SetUp button.
Wit ’—_| Cancel

Quick recording setup is explained in detail
next.

Sample Period [seconds]
B & Small Diameter Metal [10)
L

™ Large Diarneter Metal [20]

" Plastic [30)
" User Defined JZI
- Mumber of Recordings 5 _I;I

Recording Interval 18 Minutes =
Memony Uzage: m

SoundSens User Guide
©Radcom (Technologies) Ltd Page 13 of 63



RADCON\

TECHNOLOGIES LTD

SoundSens User Guide
Leak Localisation and correlation

The time line shows a series of logging

sessions as dark blue lines. (SEE

14.02:4014:10:04 14:26:14 144024 146434 16:10:44
DIAGRAM BELOW)
| | If the time line is red then check the
14:_0?:_56 142306 14:38:16 16326 160836 “Start Serles At TIme/Date” Values are
==L not in the past (SEE NEXT DIAGRAM).
Start Seriez
o] © et Tmemas  [wamr2007 - 141000 = It is possible to set a date and time for the
_ recording series to start
-
et = NOTE : Do not set a start time more than 36
hours in the future.
Start Series Alternativly you can set the loggers to wait for
|8 © AtTime/Date | = — | a period of time before starting.
& it [15 Mindes =] You can set the waiting time between 1
"""""" 15 Minates minute and 3 hours.
20 Minutes
28 Minutes . . .
an Minutes Make sure you have sufficient time to deploy
5 Mintes the pods before the run starts!
it ) et I M
Racording 1 | | Racording 2 | I Raconding 3 |
P = \ e
Hiway Tlfi.__ I
Black line

indicates the time
now

Quick Recording ‘ieries Setup

r

14:25:14

IA’

144024

14:55:34 1510044

-

First light blue
space is Wait time

Cancel

|03/07/2007 | |14:10:00

15 intes <]

F

Dark blue lines are

recording times

Sample Period [zeconds]
{« Small Diameter Metal [10]

_H
(" Large Diameter Metal [20)
" Plagtic: [30]
™ User Defined _|:|
Mumber of Fecordings 5 _%I
Recarding Interval 15 Minutes

Memaory Usage;

SoundSens User Guide
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SETTy 2 Feine | seeais] Select the sample period.
B @ sl Cienete bz (i) This is determined by the pipe material and
(" Large Diarmeter Metal [20] diameter
" Plastic [30]
£ User Defined = Suggested sample periods for pipe materials
and lengths are shown below.
Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8” +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4"MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+

NOTE : On sites with mixed pipe material always select the longest sample period. So if
you have some 6” and some 8” Metal (less than 500 metre lengths) select 20 seconds.

Number of Fiecardings 5 Set the number of recordings
4=+ Recording Interval 15 Minutes - (max 9)’ and set the recording interval
o between 1 minute and 3 hours
Memary L zage: m ( )

The recording interval is the gap between the START times of each recording.

e.g. if three recordings of 1 minute each are set to start at 1AM with a recording interval of
1 hour then the start times will be 1am, 2am, 3am. If the recording interval is 15 minutes
then the start times will be 1am, 1:15am and 1:30 am.

Radcom recommends 3 recordings — see explanation below.

The recording interval needs to be set with local knowledge in mind. Think of how long it
takes for a toilet to fill in your local area, and set the recording interval to that time. This
will help reduce the detection of noise which is due to legitimate consumption.

This is also partly the reason why we suggest 3 recordings. If a logger detects a noise
which can be put down to legitimate usage then hopefully on the second or third recording
the usage will have stopped.

Number of Fiecordings [ Some combinations of sample periods and
|- Recording Interval 15Minstes  »|  Number of recordings will cause excess
memory usage. This is due to memory size
restrictions in the logger.

temor Uzage:

SoundSens User Guide
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Quick Recording Series Setup g . . .
After you are happy with the settings in

. ! | | | | | | the setup window, click OK.

14:10:04 14:26:14 1440024 14:66:34 16:10:44

1402 :40
Start Series = -
oK
b@ ¢ At Tme/Date  |03/07/2007 w| (141000 - ‘!'
" Wwiait Cancel

Sample Period [seconds]

B ¢ Small Diareter Metal [10]
" Large Diameter Metal [20)
" Plastic (30

" User Defined _|:|

Mumber of Recordings 3 =

1= Recording Interval 15 Minutes
temary Usage: m

The SoundSens software should
communicate with the suitcase.

. 15:46:02 15:48:12 15:50:22 15:52:32 15:54:43

15:43:58

Start Senies

S oK J
|-

Initializing Suitcase
g
_E

E stimated Time Remaining: 0 min 12 sec

5.

" User Defined | j

Murnber of Recording: 5 J;I
Recording Interal 2 Minutes -
Memaom Usage: m

SoundSens E|
The SoundSens software will display this message if the

\l,) Upload Completed successiully, | S€tup worked. Click OK to continue.

Deploy SoundSens correlation pods ( i.e. loggers) on site.

You should have sufficient time to deploy the pods before the run starts.

As you deploy make a note of the SERIAL NUMBER of the Pod and it’s location on site.
CONTINUED...

SoundSens User Guide
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Quick recording setup with Multiple Cases

Connect the suitcases together as shown in the section “Information regarding daisy
chaining multiple cases together”

Follow the instructions from the section “Quick recording setup”.

At the stage of upload you will notice the software communicates with each suitcase and
each logger within in turn.

SoundSens User Guide
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After uploading the settings to the loggers the SoundSens software will look something like

this...

& Radcom SoundSens - [Pipe Layout]

[ Fle Comms Correlation Wiew Tools ‘Window Help

SoundSens User Guide
Leak Localisation and correlation

sl 8| Y

N = | d 8@ | pE a8 By
x

‘Wizard Bar — '{s-.| ’%Eﬁ| | Eﬁ|

0 : .
. This countdown timer

23 Open Pipe layout shows how much time

menu

is left before the logging
starts

1 Recording Setup

2 Create Pipe Layout

3 Download

4 Correlate

Save

Save After Each Stage

EEX
00:00:33 (1)
oundSens/| 2

Eearch: |
Tapics l Search Results |

Intraduction

Getting Started

Wizard Bar

Connecting the Hardware
Configuring a Recording

]/

Pipe layout area
L—

Pipe layout toolbar

v
<) 3
A
S B A |
Fipe Join Test Comment k] KRS V6 v

The number in
brackets shows W
how many logging [
sessions are left 2

ST T S OIS T T T TTTETT A
Hard Dirive or can be stored across a
Metwark to a File Server.

Correlation analysis can be undertaken 'On
site'with a Lap Top PC, or can be
downloaded from the Correlating Pods ata
later time. Furthermaore the collected data
can be re-analysed from the files stored on
the PC's hard drive or file server with
alternative filter settings and correlation
processors if required.

Getting Started

This help bar may he increased in size by
dragoing its left side, or made full size with
the maximise button.

It may be removed from the display with its
Close hutton, orvia the “iew' Menu option.
The "iew' menu may also be used to
display the har after it has been removed.
The initial state of the help bar may be
configured in the 'Startup’ options, found on
the options 'General' page {Tools' menu,
Dptions. ..

Acwizard bar is provided to ouide vou

The next step is to create a pipe layout.

Creating a pipe layout is explained in the Pipe Layout section within the Dealing With Data

chapter of this manual.

REMEMBER TO SAVE REGULARLY (PAGE 8)

SoundSens User Guide
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Setup Without PC

Basic Carry Case Operation

Please note

When the carry case is not being used it will switch to a low power standby mode for
battery conservation, so the carry case display will turn off after 20 seconds if no buttons
are pressed. If you are in the middle of making any changes or setting up a recording
session you will have to start again.

The carry case display can be reactivated by pressing OK, CANCEL, or MODIFY. The
first thing you see on the display will always be the time and date — You must check that
this is correct before setting up a recording. However the chances of the time being
wrong are very small because every time the SoundSens software communicates with the
carry case it will synchronise the time.

In addition to the time/date this screen can also show

e BATTERY LOW (if the battery needs charging)

e BATTERY CHARGING (when the charger is plugged in)

e Recording countdown (time until next recordings starts) if neither of the above apply
and a recording has been set up.

The format for the recording countdown is: HH:MM:SS (N)

HH —Hours

MM  — Minutes

SS - Seconds

N — Number of recordings remaining

Pressing the MODIFY key cycles through the main options.
To select an option press OK.
Pressing CANCEL returns to the time/date screen.

Main options (Press Modify to cycle through):
e Time/Date

e Setrecording 1? (30min delay) — daytime quick recording setup
e Setrecording 2?7 (2am start) — overnight quick recording setup
e Recording setup? — Custom recording setup

e Download data?

e Stored data

e Settime/date

SoundSens User Guide
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Set Time / Date

Setting the time is rarely necessary as the unit contains an accurate clock, and when
connected to a PC the time and date are updated.

1. Press MODIFY to cycle through the menu options until you see “Set Time / Date”
2. Press OK to enter edit mode

3. Use the MODIFY key to change the value

4. Press OK to move to the next value

Recording options

There are three options for setting up a new recording.
1. Daytime Quick Recording
2. Overnight Quick Recording
3. Custom Recording

This table should assist you in deciding weather one of the pre-programmed sessions will
be suitable, or if you need to set up a custom recording.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8” +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4’MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+

SoundSens User Guide
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Daytime Quick Recording Setup

This sets up a recording session which will start after a 30 minute delay. Three recordings
will be made each 20 seconds long, five minutes apart.

Delay to start of recording: 30 min
Interval between recordings: 5 min
Length or each recording: 20 sec
Number of recordings: 3

Check the table at the bottom of this page to see if it is suitable for your test.

1. Press MODIFY to cycle through the menu options until you see “Set recording 1”
2. Press OK to setup the quick recording

If the loggers contain any data then it will be downloaded before the new recording is set
up. This ensures that the data in the loggers cannot be lost accidentally by setting up a
new recording. All recordings will be available for download in the SoundSens software.

When the recording setup is complete the screen will show a confirmation message, e.g.

4 LOGGERS -0—-
PROGRAMMED -000

The number of loggers programmed is displayed, and the right side of the screen shows a
map of the positions of the programmed pods (‘O’ represents a logger present and a *-*
shows a vacant position). If this differs from the actual positions of the loggers below the
most likely explanation is that the windows on top of the pods are dirty or that an object is
on top of the loggers.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8” +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4"MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+

SoundSens User Guide
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Overnight Quick Recording Setup

This sets up a recording session which will start at 2am. Three recordings will be made
each 20 seconds long, one hour apart.

Recording start time: 2 am
Interval between recordings: 1 hour
Length or each recording: 20 sec
Number of recordings: 3

Check the table at the bottom of this page to see if it is suitable for your test.

1. Press MODIFY to cycle through the menu options until you see “Set recording 2”
2. Press OK to start the recording setup

If the loggers contain any data then it will be downloaded before the new recording is set
up. This ensures that the data in the loggers cannot be lost accidentally by setting up a
new recording. All recordings will be available for download in the SoundSens software.

When the recording setup is complete the screen will show a confirmation message, e.g.

4 LOGGERS -0—-
PROGRAMMED -000

The number of loggers programmed is displayed, and the right side of the screen shows a
map of the positions of the programmed pods (‘O’ represents a logger present and a *-*
shows a vacant position). If this differs from the actual positions of the loggers below the
most likely explanation is that the windows on top of the pods are dirty or that an object is
on top of the loggers.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8” +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4"MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+
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Custom Recording Setup

This option sets up a recording with user-defined settings.

Press MODIFY to cycle through the menu options until you see “Recording Setup”
Press OK to start

For each setting number use the MODIFY key to change the value

Press OK to move to the next setting

rObM=

The options available are:

1. Recording Start Delay
e 1,5,10,15,30 or 60 minutes
e At the beginning of an hour (press modify to cycle through)

2. Length Of Each Recording
e 10, 20, 30 or 60 seconds

3. Recording Interval (time between recordings)
e 1,2,5,10, 15, 20, 30, 45 or 60 minutes

4. Number Of Recordings
e 10, 20, 30 or 60 seconds

This table should assist in selecting the recording options you need.

Pipe Short distances Metre Long distances Metre Very long
distances
Up to 6” Metal 10 Seconds 500 10-20 Seconds 1000
8” +Metal 20 Seconds 400 20-30 Seconds 800
Up to 6” AC 10 Seconds 100 20 Seconds 500
8"+ AC 20 Seconds 80 30 Seconds 500
Up to 4"MDPE?PVC 30 Seconds 50 60 Seconds 100
4” + MDPE/PVC 60 Seconds 50 120+Seconds 100
300+Steel 20 Seconds 500 60 Seconds 1000+

NOTE : On sites with mixed pipe material always select the longest sample period. So if
you have some 6” and some 8” Metal (less than 500 metre lengths) select 20 seconds.

The recording interval needs to be set with local knowledge in mind. Think of how long it
takes for a toilet to fill in your local area, and set the recording interval to that time. This
will help reduce the detection of noise which is due to legitimate consumption.

This is also partly the reason why we suggest 3 recordings. If a logger detects a noise
which can be put down to legitimate usage then hopefully on the second or third recording
the usage will have stopped.

Continued...
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For the last setting, ‘number of recordings’, if a value is selected that uses more than the
available memory in the logger then exclamation marks will be shown as a warning. For
example if the recoding length is set to 60 seconds and the number of recordings is set to
4 then the display will show:

NUMBER OF
RECORDINGS:4 !!

The exclamation marks show that the logger memory will overflow if this combination of
settings is used. In this situation, use a lower number of recordings or a shorted recording
time.

If the loggers contain any data then it will be downloaded before the new recording is set
up. This ensures that the data in the loggers cannot be lost accidentally by setting up a
new recording. All recordings will be available for download in the SoundSens software.

SoundSens User Guide
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Downloading Data To The Carry Case

Data can be held in the carry case and downloaded to a PC or Laptop at a later stage. To
download data after a recording:

1. Place the pods back into the case (in any order or position) and lower the front
panel.

2. Press MODIFY to cycle through the menu options until you see “Download Data”

3. Press OK to start the download

A message will be displayed during data transfer. After downloading data from the pods a
confirmation message is shown. This is the same format used after setting up a recording
and shows which loggers have transferred data.

DOWNLOAD -
COMPLETE -00-

Viewing Stored Data Details

This option shows a summary of data sets stored in the SoundSens i. A ‘set’ is the
collection of data transferred during a download. The summary shows the set number,
number of pods used and the start time of the first recording, e.g.

SET: 02 PODS: 06
09:50 20/02/07

1. Select the Stored Data? option with MODIFY
2. Press OK to view the summary for the first set
3. Press OK to view the next set

When all sets have been displayed there is an option to delete the last set. Note the
delete operation cannot be undone.

1. Select the Stored Data? option with MODIFY
2. Press OK until all the sets have been seen and the message “Remove last set” is
shown
To delete the data use the MODIFY key to select YES then press OK

Memory Capacity

There is enough memory in the case to hold 4 downloads from 8 SoundSens i correlator
pods which are full of data. When the case and all the pods are full of data you will not be
able to record any more and you will see “Memory Full” on the display. Either download
the data to a PC or erase some data from the View Data menu.

One pod will hold approximately 120 seconds of data.

SoundSens User Guide
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SoundSens Case User Interface

Summary

Press any key to
wake up display.

First screen is always
Time and Date

Time and Date

Press Modify

()

Set Recording 1?
(30 Min Delay)

Press Modify

(—

Set recording 27?
(2 am Start)

Press OK to select an

Press Modify | item. _
Further explanation

below.

()

Recording Setup?
(OK) To Start

Press Modify

(—

Download Data
(OK) To Start

Press Modify

(T

Stored Data
(OK) To View

ﬁ Press Modify

Set Time/Date
(OK) To Start

Pressing Modify
returns to
Time and Date

SoundSens User Guide
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Set Recording 1 (30 Minute Delay)

Set Recording 1 (30 Min Delay) > Press OK
Press any key to wake up display.
Time and Date should be displayed. A recording session will be set up

with the following settings...
Press MODIFY once

Display should read... 3 Recordings
. 20sec Duration
Set Recording 1? 5 min Intervals

(30 Min Delay)

This is not shown on the display.

ﬂ The display will

show
The number of loggers programmed Setting up
depends on the number of loggers in the recordings
case.
Each 0 shown on the right represents a ﬂ Followed by
logger in the case.
\ 8 Loggers 0000

Programmed 0000

The display will then change to a
countdown timer showing the time until the
recording starts and the number of

recordings left (number in brackets).

v If a recording is taking place
14 31 04/02/07 then the display will show the
Rec 00:00:00 (3) following message.
Please Note:
When the loggers have been programmed the display
will switch off after 20 seconds to save battery power. v

14 :31 04/02/07

Wake up the display by pressing any key. It should Recording in progress

show the current recording session countdown time, or
the time and date if recordings have finished.

SoundSens User Guide
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Set Recording 2 (2am Start)

Set Recording 2 (2 am Start) > Press OK
Press any key to wake up display.
Time and Date should be displayed. A recording session will be set up

with the following settings...
Press MODIFY twice

Display should read... 3 Recordings
. 20sec Duration
Set recording 27 1 hour Intervals
(2 am Start)

This is not shown on the display.

ﬂ The display will

show
The number of loggers programmed Setting up
depends on the number of loggers in the recordings
case.
Each 0 shown on the right represents a ﬂ Followed by
logger in the case.
\ 8 Loggers 0000

Programmed 0000

The display will then change to a
countdown timer showing the time until the
recording starts and the number of

recordings left (number in brackets).

v If a recording is taking place
14 31 04/02/07 then the display will show the
Rec 00:00:00 (3) following message.
Please Note:
When the loggers have been programmed the display
will switch off after 20 seconds to save battery power. v
_ _ 14 :31 04/02/07
Wake up the display by pressing any key. It should Recording in progress
show the current recording session countdown time, or

the time and date if recordings have finished.
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Set User Defined Recording

Set User Defined Recording

Press any key to wake up display.
Time and Date should be displayed.

Press MODIFY three times

Display should read...

Recording Setup?

(OK) To Start

After the loggers have been
programmed the display will change to
a countdown timer showing the time
until the recording starts and the
number of recordings left (number in
brackets).

Press OK
Display will show v

Recording Start
Delay 01Min

Press OK to accept
Display will show

Length of each
Recording

Press OK to accept
Display will show

Recording Interval
Delay 01Min

Press OK to accept
Display will show

Number of
Recording :3

Press OK to accept
Display will show

Setting up
Recording

Followed by

8 Loggers 0000

14 :31 04/02/07
Rec 00:00:00 (3)

If a recording is taking place
then the display will show the
following message.

A 4

14 :31 04/02/07
Recording in progress

Please Note:
When the loggers have been programmed the display
will switch off after 20 seconds to save battery power.

Wake up the display by pressing any key. It should
show the current recording session countdown time, or
the time and date if recordings have finished.

The number of loggers programmed
depends on the number of loggers in the
case.

Each 0 shown on the right represents a

Programmed 0000

A

logger in the case.
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Download Data From Loggers to Carry Case

Download Data Press OK
Display will show
Press any key to wake up display. :> Downloading From
Time and Date should be displayed. Loggers...
Press MODIFY four times Followed by

Display should read...

Downloading 0000

Download Data Complete 0000
(OK) To Start

The number of loggers downloaded in the case is represented
by a 0 shown on the right hand side of the display.

When the download data option is used, the data is read from
the loggers and held in the memory of the case. It can then be
downloaded to the SoundSens software at a later stage.
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View Stored Data

View Stored Data

Press any key to wake up display.
Time and Date should be displayed.

Press MODIFY five times
Display should read...

Stored Data

(OK) To View
Press OK This indicates that the first
Display will show recording in the memory of the

/ case had 8 loggers and was
Set: 01 PODS: 08 recorded on 30/1/07 at 17:09

17:09 30/01/07

Press OK -
Display will show Here.you have the optlpn of
deleting the last recording held

in the case. By default NO is
selected. If you want to delete
the last recording press Modify

Set: 02 PODS: 08
17:49 30/01/07

Press OK
Display will show

Press MODIFY
Display will show

Remove Last Set Remove Last Set
Yes (--No--) :> (--Yes--) No
Press OK

Display will return to ) Press _OK
Display will show
Stored Data
(OK) To View Set
Removed

And then the display
will return to

Stored Data
(OK) To View
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Set Time and Data

Set Time and Date

Press any key to wake up display.
Time and Date should be displayed.

Press MODIFY six times
Display should read...

Set Time/Date
(OK) To Start

Time and Date
Displayed

Press OK

Set Hour

Press Modify to change value
Then press OK

Set Minutes

Press Modify to change value
Then press OK

Set Day

Press Modify to change value
Then press OK

Set Month

Press Modify to change value
Then press OK

Set Year

Then press OK to set the time.
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Dealing With Data

Creating A Pipe Layout

It is possible to either create a basic schematic layout of the underground pipe work, or
add a background image for illustration purposes.

Pipe Layout Menu

Add map / Move pipe layout items Logger correlation
background image selection
2
'{h—%ﬁ—l&: ‘
Show / Hide pipe layout toolbar Adjust zoom level

SoundSens User Guide
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Add a background image (optional)
@ Fas) E’ﬁ| @«| M| Click the Add Map / Background Image button.

Pipe Layout Backgrond Bitmap EJ Click Browse and use the standard
Pipe Layout Background Bitmap windows explorer interface to locate a

_ m bitmap (bmp) file to use as a
File: Browse... background.

You must click the “Display Bitmap” tick
@isplay Bitmap

box for it to appear on the layout. By

default it is not ticked.
Fipe Layout Backaround Bitmap

+—

Harizantal 100 % At a later stage you can go back to this

menu and un-tick this option to remove

|:| I Wertical 100 % the map.

SoundSens software shown below with map background image.

¥ Radcom SoundSens - [Pipe Layout]

[#] Ele Comms Correlstion Yiew Tools Window Help -8 x

O = | W & =g
Wicand Bar x| | e 8 vy \:‘h SoundSens
D New : S e [ 0000 =

2 /J% Topics I Seaich Hesu\ls}

& Open N

Introduction ~
Getting Started

“izard Bar

Connecting the Hardware

Configuring & Recarding b

502>

1 Recording Setup

Introduction A

2 Create Pipe Layout (,9‘33' ﬁp SoundSens is a poweriul software package
Ca &‘5‘ used with SoundSens CF {Correlation Pod)

= A Loggers to identify the presence of leaks in

™ R pipe wark and determine the actual position

3 Download ofthose leaks using correlation technigues

The Leak noise data is stored by the

SoundSens software onto the PC's internal

R Hard Drive or can be stored across a
(pra ) s y Metwork to a File Server.

"f{; o Correlation analysis can be undertaken 'On
site'with a Lap Top PC, orcan be

4 Comrelate

o,
@ .

- ) downloaded frorn the Caorrelating Pods ata
SaVE \4‘5 |ater time. Furthermore the collected data

Q?D ;‘9755 can be re-analysed from the files stored on

the FC's hard drive or file server with

alternative filter seftings and correlation
processors if required

Getting Started

Save After Each Stage Snmbkaﬂa Close

This help bar may be increased in size by
i Westend Rd dragning its left side, or made full size with
Z —Rd | |the maximise button
< > It rmay be rernoved from the display with its
» | |Close hutton, orvia the “iew' Menu option,
% &@ A @ @ The “iew’ menu may alsa be used fo
display the bar after it has been remaoved
Pipe Jain Text Comment 3723 3726 3727 || [The initial state of the help bar may be
confiqured in the *Startup’ options, found on ™
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Pipe Layout Toolbar

S B A

Fipe Jain Text Comment 723 725 726 arey

The pipe layout toolbar at the bottom of the pipe layout area shows Pipe, Join, Text
Comment and the serial of each logger used.

Putting loggers on the map

Start by selecting a logger and with the mouse button held down drag and drop it from the
toolbar onto the pipe layout area. It is not important to place the loggers precisely as the
software pays no attention to position on the screen. The most important data is pipe
length and material type which is entered later.

& Radcom SoundSens - [Pipe Layout] [:][E]g|
-8 X

[# File Comms Correlation View Tools windgw Help

D | = |} 8| % g e8 8 e [ ¥

‘“Wizard Bar ﬂ \{\“| ’%’% @/| %| |'—3 SOUI‘IdSEﬂS Eﬂ
D NBW A Search:

Topics l Search Results ]

Introduction ~
= Open Getting Started
‘whizard Bar
Connecting the Hardware
Configuring a Recording b

1 Recording Setup

Introduction A

2 Create Pipe Layout SoundSens is a powerful software package
usedwith SoundSens CP (Correlation Pod)
Logoers to identify the presence of leaks in
pipe work and determine the actual position
3 Download of those leaks using correlation technigues
The Leak noise data is stared by the
SoundSens software onto the PC's internal
Hard Drive ar can be stored across a
Metwiork 1o a File Server.
@ Correlation analysis can be undertaken 'On
site’ with & Lap Top PC, or can he

4 Corelate

A downloaded frarm the Correlating Pods ata
Save later time. Furthermore the collected data
can be re-analysed from the files stored an
Sawe After Each Stage the PC's hard drive or file server with
alternative filter settings and correlation
processars if required.

Getting Started

This help bar may be increased in size by
dragging its left side, or made full size with

* || |the maximise buttan.
£ b3 It may be removed from the display with its
Close button, or via the Wiew' Menu option.
% @@ A The "iew' menu may also he used to
: ; displaythe bar after it has heen removed.
Fipe Join - Test Comment The initial state of the help bar may e
confiqured in the 'Startun’ options, found on ¥

Putting joins on the map

To add a join on the map click once on Join and then click once on each place that
you need a join. Only use a join

@ (B0 A

Pipe Jain T et Cormrment 3723 7R 726

e for a

change in pipe direction, or pipe material.
REMEMBER TO SAVE REGULARLY (PAGE 8)
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Putting text comments on the map

To add a text comment click Text Comment and then click on the map where you wish to
see a text comment.

%@@llll

Pipe Jain 3723 725 3726 37T

o iy i= L
“ s 2|k |
~
& 8
Text Comment El
Hello world oK |
EanCEI_J
Jﬁ %rientation Horizontal _:_]
Haorizantal ’_\
Wertical [907) =
Wertical [270°)
0
5" M,
&
M
< | &
S Be /A
[ Fipe Jain Test Comment
Place Text Comment

Type your text comment here, and pick a text direction, then click OK
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Adding connecting pipe work to the map

After dragging and dropping the loggers onto the pipe layout area and adding the join
points you can start adding the connecting pipes.

) B A

Fipe Jain Text Carmment 3723 3725 726 7287
Click the pipe icon once and then move the mouse pointer over one of the loggers. Click
and hold the mouse button down over the first logger and then move the mouse to the
logger you wish to connect it to.

[

[- B[]

0= | || 8| % |28 e8 b s Y | ' '
Wizard Bar bS] | 2| 3\ SoundSens 2
Bl NEW i Search:
@ Topics l Seaich F\esults]

Intraduction ~
=] Open Getting Started
“wizard Bar
Connecting the Hardware
1 Configuring a Recording

Recording Setup
Pipe Properties... gj Introduction ~

2 Create Pipe Layout v Select from materialz database SoundSens is a powerful software package
used with SoundSens CP {Correlation Pod)
Material: |WC j Loggers to identify the presence of leaks in
pipe wotk and determine the actual position
3 Download Length: 1000.00 Metres ofthose leaks using correlation technigues.
The Leak noise data is stored by the
SoundSens software onto the PC's internal
- Sound Yelocity: B50.00 mrs/sec Hard Drive or can be stored across a

4 Correlate Metwark to a File Sarver.

Correlation analysis can be undertaken 'On
site'with & Lap Top PC, orcan he

Diameter: 12mm -
i3
= i -m Cancel downloaded from the Correlating Pods ata
Save later time. Furthermore the collected data
)

can hbe re-analysed fram the files stored on
the PC's hard drive or file server with
alternative filter settings and correlation
processors if required.

Save After Each Stage

% @ Getting Started
This help bar may be increased in size by
dragging its 1eft side, or made full size with

|| |the maximise hutton.
< > It may be removed from the display with its
B - Clase button, orvia the View' Menu aption
% @@ A The “iew' menu may also be used to
: _ display the bar after it has been remaoved.
Pipe Jain Text Comment The inftial state ofthe help bar may be
confiqured in the ‘Startup’ options, found on -

Flace Pipe

X

Pipe Properties... Selecting a material from the drop down list

will set a sound velocity. Un-tick “Select from
materials database” to enter your own sound

M aterial: | T ﬂ velocity.
M Enter the pipe length
Length: |1000.00 Metres ——
S ound Velocity |EEIZI.IZIIII ey 2 Select the pipe diameter
— from the drop down menu

Diarneter: 12mm -
|l lcickok

|:| K. I L=rr=| g Lo e | ] I 1

Iv Select from materials database
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Changing Properties on Pipe Layout

B Pipe Layout

el £ 2y

Remove 3
Make Survey Sweep

Right click on the pipe you want to G
change and select Pipe Properties
from the menu.

170.00 m

o

Edit Pipe Layout Id's...

150.00 m

Pipe Properties...
Disable Pipe

100.00m

Fipe Jain Text Comment

Pipe Properties... E|

[v Select from matenals database

Material PV j//ﬁnge the pipe length here
/I

Length: |1 000.00 Metres  ——=

Change the pipe material here

. Change the pipe diameter
Sound Velociy [BE0.00 mirs/sec | ___— from the drop down menu here

//—I
12 -

Diameter:

Click OK to keep the changes
Ok Cancel | or Cancel to leave unchanged.

REMEMBER TO SAVE REGULARLY (PAGE 8)
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Download loggers

The loggers can be collected when the recordings have finished.

If you leave the SoundSens software running then you will see the following information to
help you tell when the recordings are being done, and when they are finished.

00:00:36 (5) «—— Time shows how long until the recording

(®] SoundSens

(®| SoundSens

starts. The number in brackets shows how
many recordings are left to do.

When is says No Scheduled Recordings it
means all the recordings have been finished.
The SoundSens software must be left running
for this to work. If the software is stopped
then the counter will reset back to showing No
Scheduled Recordings.

Note : When the loggers are put back in the case for downloading they can go back in any
order.

“Wizard Bar ﬂ

[

New

= Open

1

Recording Setup

2

Create Pipe Layout

\\3\“—1}_'#"'1}(“'

'

With the SoundSens software running and the USB cable
connected between the laptop and the suitcase click the
Download button.

s
ey
Downloading All Recordings

[Recording Set 1, Suitcase 1, Position 1, 3731]

E ztimated Time Remaining: 1 min 32 sec

SoundSens g]

\1{) Download Completed Successfully,

Loggers Will Be Excluded

4

If any fail to communicate you
will see this error message.

': The following loggers will be excluded beacuse they have no recorded data:
—> |
3731

Save
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Downloading Loggers (Multiple Suitcases)

Connect the suitcases together as shown in the section “Information regarding daisy
chaining multiple cases together”

Connect the USB cable to the first suitcase.
Click the Download button.

The software will ask for conformation about the number of cases. If this number is
incorrect ensure the USB cable is connected to the first suitcase, and that all the cases are
connected together correctly.

If the number of cases is correct then the download can begin. After each box of loggers
has been downloaded the software will ask for the USB cable to be moved to the next box
in the line. This process will be repeated until all the connected boxes have been
downloaded.
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Correlation

After the data has been downloaded correlation begins automatically.

¥ Radcom SoundSens - barrack road 3.ssd E|E|FZ|
File Comms Correlation Wiew Tools Window Help
D w | || &8 % g8 e8| g o & | (Y

“wizard Bar i{

B € Lorretatio gh Reso 0 3 Fipe Layout
O New %] | 2] | & Ditance Damain = | e85 £ vy
Correlation | Average | (1) Jan 22 2001, 02:30:048M | (2) Jan 22 200
= Open 8 10260 m ™ 55.6%
—
202 © 1426m 298 (1)888%
14990 m a7 .E% -L
1 Recording Setup 284 11gzgm 30 (11871% W
5 9360 m a a7 1% J J a
— z
298 4dzam 301 (1)8689% =
2 Create Pipe Layout 8 E3:70n g % ' S ¥ 603
294 gogam 298 (N717%,, o ol u@ 'y = ‘P

) A
a 45.20 m g B3T3
=
3 Download 292 R0 M 309 (1) 69.9%

4 Comelate

Save

Save After Each Stage

Q@ Bo A

Fipe Jain Text Comment

|~
v

|Daone:

|~

A5 Winaoky  HAep

Lgm@ Lﬂﬁ @nﬁd : :;i: _4)’ 4 Comelate

4

/

To begin the correlation process manually after opening a data file click the Perform
Correlation button, or click Correlate on the left menu bar.
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EZ Exhaustive Correlation - High Resolution

After correlation has finished
L] i] ]M:DistanceDomain _'J
Correlation | verage [ (1) 3an 22 2001, D2:30:048M [ €23 230 22 2001, D2:45:09am [ (3 Jan 22 Z001, D3:00:0440 | the SOftware Sorts the data'
iy 7 ] | | The most likely leak

292 14.26 m 293 (1)888%

sssn o e 1 | 1 correlations will be at the top.

234 1azam 30 (1871%

s 93 60 m a 87 1%
_
258 4d3om 30 (11963%
53.70 m T08% 1
294 gooem 208 (DTIT% e R gl

4320 m B9.7%
e ! A
é%z 280m 3% 11 69.9% by M ry s ) Al i

Done

B Pipe Layout E”Elg‘ . .
| 2% | Thelocation of each possible

- -l leak is marked on the map
by red markers.

wWOgEk

T000m

S Bo A

Pipe Jain Text Comment
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Click once on the recording graph and the blue circles will indicate which two loggers

have been correlated between.

A third smaller blue circle will show the possible leak location

8 Radcom SoundSens - barrack road 3.ssd

File Comms Correlation View Tools Window Help

D & W 8| ® 2| | By o

L EX

“Wfizard Bar
0 New
Correlation | Average |(1) Jan 22 2001, 02:30:044M (2} Jan 22 2001, 02:45:044M ‘ T
10260 m 8B.5%
& Open o L « ‘ 1
202 © q428m 208 (1)8G8% - y
8 149.90 m 8 87 5%
—
i 1987 1%
1 Recording Setup 284 1rgzam 301 () )
8 9360 m B o
=
258 4039m 301 (1)968%
53.70m

2 Create Pipe Layout
294 B00Gm 298
43.20 m

4 Correlate

Save

Click once on recording

graph.
Loggers circled.

Save After Eag

.—‘ g ' b
3 Download 292 © gpom 301 A1)ES%

¢l 2|y

W6k

[T

—> @ z@ﬁm

(292 -> 295 = §8.8% , 14.26 Metres POSSibIe Ieak |ocation

Jain

A :

Test Comment

Double click on the recording graph to see a close up view.

% Correlation [ 292 -> 298 )

B=E3
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The Basic Recording Graph

Two logger serial
numbers between
which correlation has
taken place

(Logger 1 > Logger 2) Leak location shown as distance from logger 1.

2% Correlation { 292 -= 298 )

(1-Jan 22 2001, 02300450 ] /]/\/ ~| ,@,‘,@L@A,@‘,@J 3u,|lef @é‘-&u|

(O R Jan 22 2001, D2:3E|:EI4AM/

14.25:&1&':@3

Distance between loggers
Sound velocity shown in brackets

o
=
>
=
E-
@
E
=
o
]
o

A
0.000 40000 50.000 100.000

Cursar:
o 10260 m (1254.01 mirsizec »
55.5% Mle ¢ ) |
298

p—————rta
ﬁ?gz T4.26 m Hogdm

Distance v Time [&bzolute]|  Coherence Sampled Data | Ruto-Spectium

Logger 1 Logger 2

Leak distance from logger 1 and logger 2
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Recording Graph Advance Features

Zoom functions

EAP AP AP AP
//"/ ‘1‘ J\

Zoom X — Zoom Y — Zoom XY — Zoom Out One Step — Zoom Out Fully

Listen to recordings from loggers

be,[dek| € X
/1

Left logger — Both loggers — Right logger — Stop playback

Graph viewing options

1-Jan22 2001, 0230.048M v | %| 1 -]
""" 4

2-Jan 22 2001, D2.45.04EM \
| )

This drop down menu
reduces the number of
graphs on the screen.

If two or more graphs are being
viewed this drop down menu
selects which one is on top. .

If two or more graphs are being
viewed this button cycles
through them putting each one
on top in turn.
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Reveal Advanced Graph Options

_LIF=E0r;

"

a8.8% [ comm—

F X Diztance

Click the small up arrow on the bottom left of the graph to reveal the advance graph
options (see below)

I agqz 4B i T
¥| [ Distance | Time[Reall [ Time [&bsolute] [ Coherence | Sampled Data | Aoto-Spechom |
Coarmrelation Band Pazsz Filker [Hz]

|292 ﬂ |29E= j Upper: 1000
|Jan 22 2001, 0230044 ﬂ Lawwer: |IZI Apply |

Logger 1 Carrelation Logger 2
Serial number |EEE ﬂ |EE"3 :l" Serial number
\Jan 22 2001, 02:30:0480M v

¥

To see the correlation graph between two different loggers just change the serial numbers
shown in the drop down menus for logger 1 and logger 2, and then click Apply.

Date and time of recording

To superimpose another recording taken between the same two loggers over the existing
graph, select it from the time and date drop down menu and then click Apply.

To change the Band Pass Filter, adjust the figures and then click Apply.
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SoundSens Software Advanced Configuration

] IE! Window  Help

Options. .,

Irnpart, ..

Export...

Import Pipe Layout,..
Export Pipe Layout...
Edit Pipe Layout Id's. ..

The General tab

Software start up options.

From the Tools menu click Options.

This is intended as a general guide

to the SoundSens

software options.

For further assistance and
explanation please contact the

Radcom technical

support team.

These changes will take effect next time the software is started.

Wizard bar
The blue bar found on the left
hand side of the screen

tartup
¥ Dizplay ‘Wizard Bar

I Reload last workspace

Software Mode
&+ Mormal

" Advanced

base:

Ticking this box
makes the software
auto save your work

'! General - Configure the startup appearance and operation of
] - !
i zoftware mode and meazurement units type. Set the pipe

I Automatically Save Document after major operations

¥ Dizplay Help Bar

v Maximize

teasurement Units
&+ Metric

" Impernal

enals database path ﬂ

General ll:ommunications Fecording Defaulls] Fipe Mayout | Carrelation | Exhaustive Enrrelalion] G4l

Help bar
Found on the right hand side
of the screen

undsens. Select the A

|E:\F'rc-glam FilestR adcom TechnologieshS ou

|E:'\M_l,l DocumentghSoundSens

Ticking this box
makes the software fill
the screen when it is
started
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The General tab (continued)

Options...

'r General - Configure the startup appearance and operation of Soundsens. Select the
o ; ! -
E— software mode and measurement units type. Set the pipe material: database path Cancel |

General | Commmicstinne | Bernding Detae | Bine | annr | I"D”E|ati,:,nl Brl e I:::urrelatiu:un] GA|r
Start the SoundSens software in Advanced or |

Normal mode. _ . tar | Change the measurement units
In Advanced mode you will see options such as

; between metric and imperial
those seen at the bottom of the correlation graph
[ Automatically SAve Document after major operations
Software Mode Measurement Units
* Marmal + Metic
" Advanced " Imperal
Pipe Materials Database: |E:'\F‘ru:ugram Filez'R adcom TechnologieshS oundS
Cefault Open Path |E:'\M_I,I DocumentshSoundSens
The default location
The location of the pipe for the SoundSens
materials database data files
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The Communications tab

Options...

b

: Communications - Select the comm port bo uge to connect the soundens suitcase o A

T the PC. Uze 'Help - Find Available Ports' for more infarmation on available ports.
e Cancel

l R ecording Defaults] Fipe Layu:uut] I:::urrelatiu:un] E shaustive I:::urrelatiu:un] GA*
I

Senzor Type |P'ru:u:|uu:tiu:un Senzor || f

Port: | COmrE

Set the default sensor

(logger) type

[v Maonitor USE Parts. Prampt when USE device cunr;m\

Synchronization Confirmation

Iv Prompt on detailed setup

Set the default

communication port

[ Prompt on quick setup

Help - Find Avwailable Forts...
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The Recording Defaults tab

The default recording options.

Change the Notch filter value for filtering out
mains frequency interference. This is set when
the software is installed, but can be changed
here (for UK it should be set to 50Hz)

Options...

Motch Filker A0Hz * | Low Pazs Filter |High ﬂ
Default Recarding Durations
1. |5mall Diameter Metal |1 0 Seconds
] |Large Diameter Metal |2|:| Seconds
3 |F'Iastiu: |3|:| Seconds
4, |L|ser Defined |E':| Seconds

These are the default recording durations for
selected pipe materials. You can change them

; Recarding Defaults - Select the Match filter zetting [mains power frequency] and the
E— default recording configurations for use with quick recording setup Cancel

General] Communications i Aecarding Defaults l Fipe Layn:nut] En:nrrelati-:nn] E xhaustive En:nrrelatin:nn] GA "l

to suit your area. For further information please

contact the Radcom technical support team.
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The Pipe Layout tab

The pipe layout area options

Options...

Pipe Layout - Enter arid walues ta zet the precizion of items placed on the layout, S

=
— and the survey sweep configuration. Survey sweep can be wzed to automaticaly
| v Cancel |

l Cormelation | Exhaustive En:nrrelatin:nn] GA|*

General] En:nmmunic:atin:-ns] Recording Defaults | F
Pipe Layout Grid 5 5
ipe Layout Gri urvey Sweep Layout

# Unitz |10 [ Automatically Build & Line
' Units [10 Pipe Defaults | " Star

Printer Settingz

i : W Multiple path warni
" Fitto page * Full Size ultiple: path wartiings

Pipe Material Pipe Colour -~
Asbestos Cement
Cask Iron ]
Copper L y
Zoncreke L [
/
To change the colour of the pipes on the pipe
layout double click on the coloured area.
Select a new colour from the menu which pops
up on the screen, and then click OK Edit Pipe Colour =

Select the required pipe colour from the list and
select OK, or double click the required colour,

Cast Iron

bl
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The Correlation tab

highlighted with it's value

preferred.

By default only one peak will be

displayed on the graph. You can
change this to a higher number if

Mid peak suppression

prevent it from happening

If the logger hears nothing then it
may put a large peak in the centre of
the correlation graph. This option will

Options...

FiEE |
i
LSRR

General] Eummunicatinns] R ecarding

FPeak Detection

Defaults ] Fipe Layout

Feak Suppreszion

Correlation - Configures hoky peaks should be detected and displayed. The kumber  #
of peaks to highlight, or a paroentage confidence may be set [all peaks abows this Cancel |

100 || E xhavstive I:::urrelatiu:un] G|+

|l& Diztance Du:umair/

f* Mumber of Peaks 1 [v Mid-peak Suppression .01
" Percentage Threshald % Peak Width [zecsl  |0.01
Leak Location Markers Out of Bracketz Markers
[v Confidence Colours [v Distance from logger Colours
from g3 = & Marken e |5 3: % Markern |
to 100 3: %  Background: Backgroun |
[ Digplay Threshold on Graph
Leak: karker Optimization Default Correlation Graph( type
[ Ophirize leak markers within 1 betres j

/

/

/[

/[

Change the default colours of your leak
location and out of bracket markers here.

SoundSens User Guide
©Radcom (Technologies) Ltd

Page 52 of 63



RADCON\

TECHNOLOGIES LTD

SoundSens User Guide
Leak Localisation and correlation

The Exhaustive Correlation tab

The default option here is All Recordings. This will perform correlation using all
the recordings in the loggers.

Use Pop-up Significant Correlations to automatically display the graph or graphs
for locations most likely to have leaks.

Options...

General] Communications

E shaustive Carrelation

[+ Al Recaordings

'! Exhaustive Corelation - Sélect ‘4l Becordings' bo corelate all logger recordings.
[ . e S : ; . .
o Faop-up Significant Corrglations’ will automatically display detailed correlation graphs o,

Fiecording Defaults | Pipe Layout | Comelation | Exhaustive Correlation l G4

N L]
[CEe=

Cancel

[ Pop-up Significant Corelations
[ Al Logger Pairs if Pipe Laypout
[ Al Logoger Pairs if Survey Sweep

AN

The 'All Logger Pairs' options specify weather to
correlate every logger with every other logger in
the layout, or perform sufficient correlations to
ensure full pipe network coverage. By default
these boxes are not ticked.

Exhaustive correlation using 'All Logger Pairs' may
take significantly longer on a large pipe network.
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The Graph Colours tab

To access the tabs past Exhaustive Correlation you need to click the right hand arrow as

indicated on this diagram

Lancel

, | Exhaustive Correlation ] G 4@

Options...

ale=

i —

araph Colours)Styles

Graph Line 5. .. V\

SoundSens User Guide

Leak Localisation and correlation

Graph Colours - Configures the gyles and colours used to dizplay data graphs, and
fonts for awiz and graph text. Select Defaults ta return to the default settings.

Pipe La_l,n:nut] En:nrrelatin:nn] Exhaustive Comelation {

Graph Line 1... | |: Backaround. .. | I—
Graph Line 2. .. |: Bis, ., |:
Graph Line 3... |: arid Lines. ., I—
Graph Line 4... | —————— Limit Lines. . | —

Configures the styles and colours used to display
data graphs as well as fonts for axis and graph text.
Select Defaults to return to the default settings.

Cancel

|
_ Cacel |
Dl

l Graph Options |

Current Grd [ Enable style Change

Graph Line &. .. B Skyvle., .. —_—
Graph Line 7...
Sty el | Enable style Change
Graph Line &... Shyvle, ..
Defaults, .. Ais Fonk (Arial) Fonk (Arial) |
N AN
N\ N\

Graph Line 1

Select the caolour and/or style for the araph item. Gradie

_____ graph background, and create a shaded background in the curent graphs colow, o,
Sampls |
Select Colour Select Style
EEEEREN | —
EEeSEe | | —
- [——— - - -
-

Select a new line colour and
style, and then click OK
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The Graph Options tab

Configures the functionality of the graph.

Options...

Cancel
....................................... R

araph Options

Cursor Line

Grid

Display Peak Position as Text Yalue on Graph
[ auto Scale Graph Text with Graph Size
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Troubleshooting

Carry Case Not Communicating with PC or Laptop

Using Serial (RS232) Cable

Check the communications port.
Tool -> Options -> Communications tab

Change the communications port number by
clicking the drop down menu and selecting a
different one.

; Communications - Select the comm part to use to connect the soundens suitcase to & 1
T the PC. Use 'Help - Find Awailable Parts' for more information on available paorts. 2 Cancel

Dml Fecording Defaults | Pipe La_l,JDutl I:Dnelatinnl E=haustive I:Dnelatinnl GAl+]

Senzor Type |F'ru:u:|uc:lion Sensor |l :J
Port: |- COMS [~

¥ Moritor USE Portz. Prompt when USBE device connection chisnges

Sunchronization Confirmation
[¥ Prompt on detailed setup

[ Prompt on quick setup

Help - Find Available Ports...

Incorrect Sensor Type

SoundSens Error

If the wrong sensor type is selected you may see an

During download the Following errors occurred: error durlng communication.
Mo Loggers Connected

The options are

Change the sensor type from the drop down menu

Pre Production Sensor

Production Sensor (The original SoundSens logger)
Production Sensor Il (Dark blue plastic logger)
Production Sensor Il (Otherwise known as SoundSens i)
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Change Sensor Type

1" IE! Window  Help

Qpkions. ..

Imnport...
Export...
From the Tools menu click Options Import Pipe Layaut...
Export Pipe Layaout, .,

Edit Pipe Layout Id's, .,

— L

Options...

'! General - Configure the startup appearance and operation of Soundsens. Select the A
] : ! -
Z—= software mode and measurement units tppe. Set the pipe materials database path Cancel

General 19 ecording Defaults ] Pipe Layout | Correlation | Exhaustive Correlation ] Gl
/ﬁ!p
[v Display wizard Bar [v Display Help Bar

CI|Ck the Communlcatlons tab / [ Reload last workspace [V M axirnize
[~ Autamatically Save Document after major operations
Software Mode Measurement Units
' Marmal f+ Metric
" Advanced ™ Imperial
Pipe Material: Database: |C:\Ploglam Filez%R adcom TechnologiessS oundS
Default Open Path |E:\M_l,l DocumentzhSoundSens

Options...

;. Communications - Select the comm port to use to connect the soundens sultcase to &

e the PC. Uze 'Help - Find Awvailable Ports' for maore information on available ports. F
oz Cancel

General ecarding Defaults] Fipe La_l,lout] Eonelation] E shaustive Conelation] GAlr

The currently selected sensor Caalipe [Praducton S ensor I >
Is shown here Pott | coms =

[v Monitor USE Parts. Prompt when USE device connection changes

Synchronization Confirmation
¥ Prompt on detailed setup
[ Prompt on quick setup

To change the sensor type

fO”OW the neXt InStrUCtlon Help - Find Awailable Ports...
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Options...

;. Communications - Select the comm port to use to connect the zoundens suitcaze to A
£—=1 thePC. Use 'Help - Find Available Parts’ for mare information on available ports. P Cancel

General  Communications ] Recording Defaults] Fipe La_l,lout] Eonelation] Exhaustive Eonelation] G|

Senzor Type |Pr0duction Senzor [l j

Port Pre-Production Sensar —L|
: Production Sensor

i Froduction Senzar |l

[v tonitor USE Ports. [y

Synchronization Confirmation
V¥ Prompt on detailed setup
™ Prompt on quick setup

~_Click the drop down menu and
Help - Find &vailable Ports... click on the type of sensor you
have.

The options are

Pre Production Sensor

Production Sensor (The original SoundSens logger)
Production Sensor Il (Dark blue plastic logger)
Production Sensor IIl (Otherwise known as SoundSens i)

Options...

'!. Communications - Select the comm port to use to connect the soundens sultcase to &
£—= the PC. Use Help - Find Available Ports' for more information on available ports. F Cancel

General  Communications lHecording Defaults | Pipe Layout Eonelation] E shaustive Conelation] GAlr

Senzor Type

After making your selection click
[ OK to save the change.

Pait:

Iv Monitor USE Parts. Prompt when USE device connection changes

Synchronization Confirmation
¥ Prompt on detailed setup
[ Prompt on quick setup

Help - Find Awailable Parts. ..
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SoundSens Software

License Agreement

Carefully read all the terms and conditions of this agreement prior to using this SoundSens Software. By attempting to load the Software
you indicate your acceptance of these terms and conditions.

License: You have the non-exclusive right to use the enclosed Program on a single CPU. You may physically transfer the Program from
one CPU to another provided that only the licensed company uses the Program. You may not distribute copies of the Program or related
documentation to others. You may not modify or translate the Program or related documentation without the prior written consent of
Radcom. You may not use, copy, modify or transfer the Program or documentation, or any copy thereof, or permit anyone else to do so,
except as expressly provided in this agreement.

Back-up and Transfer: You may make one (1) copy of the Program solely for your own back-up purposes. You must reproduce and
include the copyright notice on the back-up copy. Transfer of Program and license to another party may only be made after written
approval from Radcom, provided the other party agrees to the terms and conditions of this agreement and completes and returns a
Product Registration Form to Radcom. If you transfer the Program you must at the same time transfer the documentation and back-up
copies or transfer the documentation and destroy the back-up copies.

Copyright: The Program and its related documentation are copyrighted. You may not copy the Program or its documentation except for
your own back-up purposes and to load the Program into the computer as part of executing the Program. All other copies of the
Program and its documentation are in violation of this Agreement.

Terms: This license is effective until terminated. You may terminate it by destroying the Program and documentation and all copies
thereof. The license will also terminate if you fail to comply with any term or condition of this Agreement. You agree upon such
termination to destroy all copies of the Program and documentation.

Warranty: Radcom warrants to the original licensee that the diskettes on which the Program is recorded be free from defects in
materials and workmanship under normal use and service for a period of 90 days from the date of delivery to you as evidence by a copy
of your invoice. During this period Radcom warrants that each program, which is designated by Radcom, as warranted in its program
specifications, supplied with the program, will conform to such specifications provided that the program is properly used on the machine
for which it was designed. If you believe that there is a defect in a warranted program such that it does not meet its specifications, you
should notify Radcom within the warranty period (the warranty period may be extended by signing a software update agreement with
Radcom) in a manner set forth in the program specification.

All back up copies are provided “as is” without warranty of any kind, either express or implied. The entire risk as to quality and
performance of the Program is with you. Should the Program prove defective, you assume the entire cost of all necessary servicing,
repair or correction. Radcom does not warrant that the functions contained in any program will meet your requirements or that the
operation of the Program will be uninterrupted or error-free or that the programs defects will be corrected.

The foregoing warranties are in lieu of all other warranties, express or implied, including but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. Radcom is not responsible for problems caused by changes made after the
publication of the software in the operating characteristics of the computer hardware, test instruments or operating systems, nor for
problems in the interaction of the Program with non-Radcom software components.

Limitation of Remedies: Radcom’s entire liability and your exclusive remedy shall be as follows:

a. With respect to defective media during the warranty period, Radcom will replace media not meeting Radcom’s

“limited warranty”, if returned to Radcom with a copy of your receipt.

b. With respect to warranted programs, in all situations involving performance or non-performance during the warranty

period, your remedy is (1) the correction or bypass by Radcom of program defects or (2) if, after repeated efforts,

Radcom is unable to make the Program operate as warranted, you shall be entitled to a refund of the money paid.

In no event will Radcom be liable to you for any lost profits, lost saving or other incidental or consequential damages arising out of the
inability to use any program even if Radcom have been advised of the possibility of such damages, or for any claim by any other party.
Update Policy: In order to be able to obtain updates of the Program during the warranty period, the licensee and persons to whom the
Program is transferred in accordance with this agreement must complete and return the attached User Registration Form to Radcom. If
this registration form has not been received by Radcom, Radcom is under no obligation to make available to you any updates.
Miscellaneous: This license agreement shall be governed by the laws of England and shall inure to the benefit of Radcom, its assigns
and successors.

Acknowledgement: You acknowledge that you have read this agreement, understand it, and agree to be bound by its terms and
conditions. You also agree that this agreement is the complete and exclusive statement between the parties and supersedes all
proposals or prior agreements, verbal or written, and any other communications between the parties relating to the subject matter of this
agreement.

Should you have any questions concerning this agreement, please contact Radcom in writing at the relevant address:

RADCOM (Technologies) Ltd.

Sentry House, 10 Romsey Industrial Park,

Greatbridge Road, Romsey

Hampshire SO51 OHR

Tel: +44 (0)1794 528 700 e Fax: +44 (0)1794 528 760
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Installation Instructions

e f o,

i SoundSens — IUSE Drivers . .
‘,-J ‘,-J Put the CD in your PC drive, and
double click the “installer” icon
—gfla AUTORUN | installer
= Setup Information ol
| KB installer
mainlagal :
le0x 119 Texk Document
Bitrmap Image

1 KB
EX Radcom Software Installer

i Application

B

] The Radcom Software Installer
window will pop up. Click the
SoundSens button.

SoundSens w321

|

Fadcom [Techhologies) Ltd.
Senty House T
10 RBomsey Industrial Park,
Greatbridge Foad

Romsey

Hampzhire “

Copyright © 2005 R adcom Technologies Lid

SoundSens - InstallShield Wizard

When the Installation Wizard
begins click Next to continue.

Welcome to the InstallShield Wizard for SoundSens

The | all § mputer. T

Instal 5t <Back | h_iNewt> Cancel
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SoundSens - InstallShield Wizard

License Agreement

- - Agree to the license, and then click
next.

RADCOM TECHMOLOGIES) LIMITED LICENCE AGREEMENT

Carefully read all the terms and conditions of this agreement prior to using this RADLOG
Software. By breaking the media seal you indicate your acceptance of these terms and
conditions.

Licence: ‘You have the non-exclusive right to use the enclosed Program on a single CPU.
“Y'ou may physically transter the Program from one CPU to another provided that the Program is
uzed only by the licensed company. Yau may not distribute copies of the Fragram or related
documentation to others. You mayp not madity of translate the Program o related
documentation without the priar written consent of Radecom, ¥ou may not uze, copy, modify or
transter the Pragram or docurmentation, or any copy thereof, or permit anyane else ta do o,
except a3 expressly provided in this agreement.

Back-up and Transfer. You may make one (1) copy of the Program solely for pour own
back-up purposes. You must reproduce and include the copyright notice on the back-up
copy. Transter of Program and licence ta anather party may only be made after written
approval from Radcom, provided the other party agrees to the terms and conditions of this
agreement and completes and returns a Product Registration Form to Radcom. [f you bansfer
the Pragram you must at the same time transfer the documentation and back-up copies or
sler the documentation and destray the back-up copies.

Installshial  <Back H Mext > [ Cancel J

SoundSens - InstallShield Wizard

Choose Destination Location

If you wish to change the location
of the installed files you may do so
here. Click next to continue.

Installst " < Back H i hlewt > | [ Cancel J

SoundSens - InstallShield Wizard

Ready to Install the Program

Click install to continue.

InstallShield < Back ”- | [ Caneel -J

OUUTNUOLTS UsE U

U
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SoundSens - InstallShield Wizard

Setup Type

Select notch filter value for
electrical noise rejection. By
default 50Hz is selected for the
United Kingdom. Then click next.

(this option can be changed from
within the software after
installation.

Tools -> Options -> Pipe Layout)

InstallShicld < Back “ Mest s Cancel

SoundSens - InstallShield Wizard

Click Finish to complete the
installation.

InstallShield Wizard Complete

Setup has finished in:

Install5hial " . sk [ Cancel J

SoundSens Finally close the Radcom Software
Installer.

Please now follow the USB
driver instructions.

[SoundSens w321

|

Fadcom [T echhologies) Ltd.
Senty House T
10 Romsey Industrial Park
Greatbridge Road

Romzey

Hampzhire w

Copyright © 2005 R adcom Technologies Lid
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USB Driver Installation Instructions

If you are installing the SoundSens software on a PC which has never had a USB
SoundSens case connected to it, you should install the USB driver.

= rdsons From the installation CD double click the
,,J “USB Drivers” folder.

=l y AUTORUN installer
E ?.TC':BLID Information - installer MFC Application
N =

Text Document

rnainlogol eﬁnv] register
N 160 x 119
Bitrap Image = | 1E
¥ Prelnstaller = Readme
gi:' plication 6 ;ek)g: Document

1 “1' 1]

e
. Setup
= ¥ Configuration Settings
1KE
—

—

u “.l "

Double click the “Prelnstaller”’ icon.

slabbus i . slabbus e Slabbus
Security Catalog = Setup Information Systemn file
10KE 9KE SSKE
=]
e Slaberm3s slabemnt 5 slabicarnm, vid
System file %ggl System file "‘& Wirkual device driver
11 KB ===1| 6KE Z4KE
e Slaber slabser e Slabser
System file Security Catalog Systern file
4KE 9KE SEKE
slabuninzk i slabunin.uzk
slabunin Windows Setup APT LIZK. File
thiindowes (R 2000 DOK provider 1 KB
e Slabunin,u9a o N slabved ved 5 slabwver,vizd
1195 Fils "“&l Virtual device driver "‘& Wirkual device driver
1KE 13KB S0KE

P e

= . slabvxd = _d. Slabw2k
Setup Infarmation = Setup Information
11 KB SKE
=]

_—
ETEl
£33

e Slabwhas
System file
7KE

slabiwadmm
Setup Information
SKE

i
3
WETTE
§-

slabwhrt
System File
GKE

<2 Install Driver

Click Install to “install” the driver.
CP210% USE to UART Bridge Cantraller Driver Set

C:\Program FileshSilabs\MCUNCP210x Brawse

Cancel |

Prelnstaller

R The Prelnstaller program will display this message if the driver
J) mmstallation Successful | installs correctly. Click OK to continue.
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CONTACT

Fluid Conservation Systems

Fluid Conservation Systems, Inc
502 TechneCenter Drive, Suite B
Milford, Ohio 45150

Toll free (800) 531-5465
Fax (513) 831-9336
Web www.fluidconservation.com

Note:

Fluid Conservation Systems, Inc reserves the right to change
products, services and/or specifications without additional

notice to the consumer.
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